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Morphology 101

This document contains detailed information regarding the contents of Morphology 101. 

I. Usage Information
A. PhotoMorph Lite
B. Matinee
C. The Morphology 101 shell
D. PhotoMorph Patch
E. Video For Windows runtime
F. Aniplay

II. More Information: Licensing Agreements & Troubleshooting
A. PhotoMorph Lite
B. Matinee
C. The Morphology 101 shell
D. PhotoMorph Patch
E. Video For Windows runtime
F. Aniplay

III. Special Offers:
A. PhotoMorph
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I. Usage Information:
A. PhotoMorph Lite

Although not a full copy of PhotoMorph, this lite version will allow you to load 
and edit some of the .PMP files on Morphology 101, as well as create your own 
animations. The .PMP files are found in the \projects directory.

PhotoMorph 1.2 adds the following features to PhotoMorph:
High Quality Morphing & Warping
Output to FLC animation files
Output to individual frames.
Image Editing
Screen Capture
Distortion Effects
Transition Effects
Additional image file support (i.e.: GIF, PIC, IFF)

See the special offers section below for upgrade information to PhotoMorph 1.2

To get started in PhotoMorph: 
Here are two run throughs to get you up and running with PhotoMorph Lite. 

Remember that context sensitive help is available - the current button your mouse is 
pointing to is described near the bottom of the Project Editor Window. Also help 
buttons are located throughout.

Tutorial 1 - Create and Display a Morph Movie:

The purpose of this tutorial is to introduce you to PhotoMorph Project and 
Animation Files. PhotoMorph Project files can be loaded, edited, and saved again. 
Animation files take up large amounts of disk space, but can be viewed in the .AVI 
Player. Once an Animation file has been created, the .AVI file cannot be edited with 
PhotoMorph. Only PhotoMorph Projects can be edited. 

To load a pre-existing PhotoMorph Project and create an Animation:

1. Open PhotoMorph Lite. The Project Editor will be on your screen.

2. Notice the row of buttons on the top of the project editor. The first button 
allows you to load PhotoMorph Project (.PMP) files. It is important to note 
that .PMP files are the only files that you can load with this button. Images 
and Animation (.AVI) files are loaded elsewhere. Click on the Load Project 
button.
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3. Select a PhotoMorph project from the Load dialog box that appears. 
PhotoMorph Projects have the extension .PMP. More projects can be 
found in the /projects directory on the Morphology 101 CD.

4. Click on the Create Animation button of the Project Editor, which by default
creates a file with the extension .AVI. Give the file a valid DOS filename. 
Wait as PhotoMorph generates the animation, based on the information 
contained in the .PMP file.

5. Once the animation file (.AVI) has been created, it can be loaded and 
played in the AVI Player. The sixth button over from the left on the project 
editor resembles a movie projector. Click on this button to open the AVI 
Player.

6. Because no .AVI file has been loaded previously, a load dialog box will 
appear. Open the .AVI file you just created. Many more .AVI files can be 
found in the \animatns directory on the Morphology CD-ROM.

7. Click on the play button.

Tutorial 2 - Create a PhotoMorph Project and Movie:

Now that you know how to load a .PMP file and how to create animations, the
next step involves making your own morph animations. Once you have finished this 
tutorial, you will have everything you need to know to start in "How the Pro's Morph".
However, you may want to take some 'play time' to make some more of your own 
movies first!

To create your own morph animation:

1. Open PhotoMorph. If you are already in PhotoMorph, select Project... New
under the File menu in the upper left hand corner of your PhotoMorph 
Window.

2. In the first tutorial we loaded .PMP (PhotoMorph Project) files by clicking 
on the Load Project Icon. We loaded Animation files by entering the .AVI 
player. It is important to note that images are loaded by their own button. 
When morphing, start and an end images are required. In the Project 
Editor you will see two blank Windows, labeled Start and End. Under each
Window, you will see a drop down list. Once an image is chosen for the 
start and end images, <<No Image>> will be replaced with the filename of 
the image that you are working with. To the right of both drop down lists, 
you will find a small file folder button. Click on the one under Start Image.
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3. Now you will be opening a start image. Under 'List Files of Type', change 
the type to JPEG. There are 300+ images on the Morphology CD-ROM in 
the /images directory which are stored as .BMP files. For now, concern 
yourself only with the .JPG images in the \pmlite directory. Specifically, 
click on SMLCAR2.JPG (you will have to scroll down the list) and press 
OK.

4. Next we need to load an end image. Click on the small Load End Image 
Button underneath the End Image Window. Choose BIGCAR2.JPG and 
press OK.

5. The Project Editor now should appear with a small sports car in the Start 
Window and a MiniVan in the End Window. Note that the Morph filter is 
chosen as the default filter in the Filter Type List. PhotoMorph Lite 
contains two filters, Morph and Warp. PhotoMorph 1.2 contains two 
additional filters, Distort and Transition. Future versions of PhotoMorph will
contain even more Filters.

6. Click on the Edit Button. This will open the Morph/Warp Editor. Again, the 
start image is located on the left and the end image is located on the right.

7. Notice the tool bar located to the left of both image. Each Button has a 
specific purpose:
a. The top button places points onto the images. What points do will be 

explained below.
b. The second button moves points. The currently selected point can be 

moved by clicking and dragging, pointing and clicking with the right 
mouse button, or with the cursor keys.

c. The third button erases points.
d. The bottom button allows you to zoom in and out upon the image. 

When this button is selected, click on the image to zoom in, shift-click 
on the image to zoom out.

8. Note that this Window can be resized as with any other Window. By 
expanding the Window, more of each image is shown.

9. Using your mouse, point to a spot on the bottom of the rear bumper of the 
sports car in the start image. Click with the left mouse button. A point will 
appear on the image and a corresponding point appears on the End 
Image.

10. Now move the cursor over to the End Image and position it over the active
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(red) point you just placed. Click and drag the point to the bottom of the 
rear bumper of the End MiniVan.

11. Place points in a similar manner in the following locations:
a. Center of rear tire
b. Center of front tire
c. Bottom of front bumper
d. Top of front bumper
e. Front of hood
f. Bottom of Windshield
g. Top of Windshield
h. Top of back of car
i. Top of rear bumper

12. Now you've placed all your 'Married Point Pairs'. We call them Married 
because they are linked together. Each point on the start image has a 
representation on the end image. By placing Married Points, you link the 
similar features of the two objects together. Once you are satisfied with 
your point selections, press OK.

13. You can preview the animation and save any still frames you would like 
through the use of the button on the Project Editor, seventh from the left, 
that looks like a Magnifying Glass. Click on it now.

14. The Preview Window appears. Use the slider to look through your 
animation's frames. Notice the other buttons in the Preview Window. The 
Up Arrow updates the image, which is useful when editing a morph. The 
second button saves the image shown to a file; this is handy for using still 
PhotoMorph images with other software packages. The third button saves 
the image to a new PhotoMorph Window, which allows you to reuse the 
image in PhotoMorph.

15. If you want to save your PhotoMorph Project, which consists of the points 
and images you have selected, click on the Save Project button in the 
Project Editor. It is the second button from the left. Save the file with the 
extension .PMP.

16. Once you are satisfied with your preview and point placement, click on the
Create Animation Button as we did in the previous tutorial. Give the 
animation a filename with the extension .AVI.

17. Once the animation is created, open the .AVI player. (Movie Projector, 
sixth from the left), load and play your animation!
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Now you know the basics of PhotoMorph. Welcome to the world of digital 
video special effects!

B. Matinee
Matinee is provided on Morphology 101 by:

Access Softek
2550 Ninth Street, Suite 206
Berkeley, CA 94710
Tel: 510-848-0606
Fax: 510-848-0608
CompuServe: 76702,776

Note: The manual states that Matinee will install into the Morphology Program
Group. This is incorrect; it installs into the Video Toys Group. Also, the contents of 
the README file in the Video Toys Group are superceeded by this README file.

1. Getting Started
First, ensure your video driver is set to 256 colors by running Windows Setup 

from the Program Manager. Under Options, choose change system settings if your 
display driver does not have 256 colors enabled. For additional information, see the 
troubleshooting section, below or your Windows and video card manuals.

After running the setup program and installing Matinee, it still must be 
enabled as the screen saver. To set Matinee as the screen saver:

1. Double Click on the Control Panel icon in the Program Manager.
2. Double Click on the Desktop icon.
3. Under Screen Saver, select Matinee.
4. In the Delay box, enter the time (in minutes) before you want your show to

start.

2. Previewing Video Clips
There are two ways to preview your show before it automatically pops up as 

your screen saver:
a. From Program Manager:

1. Display the Morphology program group and double click on the 
Matinee Play icon.

b. From the Control Panel
1. Double Click on the Control Panel icon.
2. Double Click on the Desktop icon.

3. In the Screen Saver box, click on the Test button to preview your 
show.

6



3. Editing Your Show
The Editing Room allows you to choose which clips to display. There are two 

ways to enter the Editing Room window:
a. From Program Manager:

1. Double Click the Matinee Edit icon in the Morphology program group.

b. From Control Panel:
1. Double Click on the Desktop icon.
2. In the Screen Saver box, choose the Setup button.

Create you show by dragging and dropping stills from the video clip library to 
the video sequencer in the order you want them to be played back. The pages of the
video clip library can be turned by the scroll arrows on the left and right. Similar 
scroll arrows allow you to roll the clips on the video sequencer.

To add your own AVI clips to the video clip library, use the file manager to 
copy the AVI files into the \matinee directory. Each clip copied will appear in the 
library, however the filename only, not a representative frame, will appear. If you 
need instructions on using File Manager, please consult your Microsoft Windows 
User's Guide.

Advanced Users will note that the Movie Directory can be specified in the 
control.ini file in the \windows directory. However: modification of this file is done at 
the users' risk.

Command Buttons:
a. Insert
Highlight a clip in the video clip library and choose the Insert button to 
insert the clip onto the video sequencer. Note: The new clip will 
automatically be inserted before the highlighted clip on the video 
sequencer. Using the mouse to drag and drop yields the same results.

b. View
Choose the View button to view either a highlighted clip from the library or 
your show in the video sequencer. Double Clicking on a still or the video 
sequencer yields the same results.

c. Delete
Highlight the still that you want to remove from the video sequencer, then 
choose the Delete Button.

d. Setup
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To enter the Setup window, which offers various playback and security 
options for your show, choose the Setup button.

4. Setting Passwords
The Matinee Setup window allows you to select password options and 

various playback modes. To protect your screen with a password, check the 
Password Protected box in the Setup window. The Set Password button then allows
you to choose or modify a password from the Set Password window.

To change the password in the Set Password window:
1. Old Password:
Type your old password in this box. This box is unavailable if you are 
specifying a password for the first time.

2. New Password:
Type your new password in this box. Passwords can contain up to 20 
characters, including punctuation, and are not case sensitive. An asterisk 
(*) appears in the box for each character you type.

3. Retype New Password:
Retype your new password in this box.

5. Selecting Playback Modes
The setup window allows you to select various playback modes.

a. Choose Backdrop
As your show does not fill the whole screen, you may choose from several
backdrops. To use a backdrop, click in the Use Backdrop check-box. The 
Choose Backdrop button then allows you to select the backdrop you want 
from the Choose Backdrop window. (Below)

b. Screen Saver Mode
Check screen Saver mode to alternate between a black background and a
backdrop. The time interval between the backdrop swap can be adjusted 
from the alternating interval box.

c. Multiple Screen Playback
Check the Overlapping Screens box to play you video in different positions
on the screen.

d. Random Play
Check the Random Play box to play the selected clips in random order.

e. Playback Rate
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Reduce the Playback Rate to speed up the display.

6. Choosing Backdrops
The Choose Backdrop window allows you to select from various backdrops 

for you videos. A thumbnail of the chosen backdrop with a movable playback icon 
allows you to position your movie on the screen.

If you prefer to create your own backdrop, check the User Defined box and 
type in the path and filename of an existing Windows bitmap (.BMP). Matinee will 
save the four most recently used files for easy retrieval in the drop-down list box. If 
you check the tiled box, Matinee will take the selected Windows bitmap and tile it 
across your screen. By using Paintbrush, some large characters, and a bright 
background, you can quickly and effectively create your own captions for your video 
clips.

C. The Morphology 101 shell
The Morphology 101 shell is documented in the help files. If you are unsure 

how to use the shell, find the nearest help button.

When installing Morphology 101, the setup program for Video For Windows 
1.1 will prompt you to restart Windows. Please Do Not restart Windows. Instead, 
upon completion, the Morphology 101 setup program will automatically restart 
Windows.

In the Settings screen, you can specify file locations for the various 
Morphology 101 components. Please do not modify these settings unless you have 
a good understanding of DOS.  

The shell is available from Andover Advanced Technologies for use in other 
Multimedia situations. Please contact us at 508-392-1362 for more information.

D. PhotoMorph Patch
This corrects some known problems with the program that you may or may 

not have experienced by installing PhotoMorph 1.2a. As a special bonus to you, you 
will find that we've included some new features! You will find a new Filters menu, 
which adds a number of new image processing tools to PhotoMorph. Also, under the
Image menu, you'll find new Contrast / Brightness and Hue / Saturation controls. 
Use these controls to adjust the coloring of your images. These are just a sample of 
the new features in store for PhotoMorph.

E. Video For Windows runtime (Version 1.1)
Upon installation, Microsoft Video For Windows runtime adds itself 

seamlessly to the Windows Media Player found in your Accessories Group. When 
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you access the Media Player (either directly or indirectly) to play .AVI files, you are 
using Video For Windows. 

This CD-ROM contains version 1.1 of Video for Windows. If you are currently 
using 1.0, (which is what ships with PhotoMorph 1.2) we recomend upgrading to 
version 1.1. If you're not sure which version of Video for Windows Runtime you are 
currently using, install the version on this disk.

F. Aniplay
Run this .FLC animation player by exiting to DOS, typing CD/ANIPLAY and 

typing ANIPLAY. The author and contact information is listed on the title screen.
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II More Information, Licensing Agreements & Troubleshooting:
A. PhotoMorph Lite
1. Licensing Agreement:

See the back page of the Morphology 101 manual except:
a. The terms of the agreement are with you and North Coast Software
b. Paragraphs 5 & 6 under license do not apply. 

2. Troubleshooting:

a. I get the error message: "Cannot Load, Missing Required Filters for this Project" 
PhotoMorph Lite does not have all the Features of PhotoMorph 1.2. Some of 

those features include Distortion and Transition Effects. If a PhotoMorph .PMP 
project file uses these Filters, the project will not load in PhotoMorph Lite. Call 
Andover Advanced Technologies at (800) 274-9674 for a special offer to upgrade to 
the full version of PhotoMorph.

b. I get the error message: "This Project File is Damaged, Cannot Load" 
There are many different file formats that PhotoMorph can load. 

Subsequently, there are a few different ways that files can be loaded. PhotoMorph 
Uses Images, such as .BMP files to create its animations. Once a person has 
created a morph, he or she can save the file for further editing as a .PMP or 
PhotoMorph Project. Commonly, this message occurs when the user is trying to load
a Image or .AVI file as a .PMP file. Ensure that you are trying to load the file type 
listed under "List Files of Type" in the Open Dialog Box, and not something else.

c. I get the error message: "Cannot Initialize Compression, Unknown Error." 
Large images (i.e.: 640x480) can be used in Morphing Projects; however, 

Intel's Indeo 3 compression cannot handle large resolutions. Use the Animation 
Parameters Button to open up that section of the Project Editor, and choose Cinepak
or None for your compression algorithm. 

B. Matinee
1. Licensing Agreement:

See the back page of the Morphology 101 manual except:
a. The terms of the agreement are with you and Access Softek
b. Paragraphs 5 & 6 under license do not apply to Matinee or any videos 

or images that are part of Matinee. 

2. Troubleshooting:
a. Installing a 256-color driver.

Matinee requires a Super VGA (SVGA) video card, which displays 256 colors;
this card will require at least 0.5 MB of video memory.  Most displays are set to VGA,
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which displays only 16 colors.  To change your display, follow the step-by-step 
instructions below.

Note:  Since you will have to restart Windows or your system after changing 
your display, it is a good idea to close all your running applications first.

1. Run Windows and enter Windows Setup in the Main program group.
2. From the Options menu, choose Change System Settings.
3. Click on the arrow at the right of  the Display line to open the drop-

down driver list.  Or press [Alt+Down Arrow].
4. Highlight your video card.  If you don't know the name of your video 

card, stop here (choose the Cancel button) and read the instructions in
section b.  If your card isn't listed, move to section c.  DO NOT 
CHOOSE THE VIDEO 7 DRIVER UNLESS YOU ARE ABSOLUTELY 
SURE THAT IT IS COMPATIBLE WITH YOUR SYSTEM!

5. Choose the OK button.
6. From the Options menu, choose Exit.
7. Restart Windows.  The new setting will be in effect.

b.  I don't know what kind of SVGA video card is installed on my computer.
To identify your SVGA board, run Microsoft Diagnostics (MSD) from C:\

windows in DOS.
1. Go to DOS by closing Windows.  (Do not use the MS-DOS Prompt 

icon in the Main program group.)
2. At the C: prompt, type [cd\windows] and press [Enter].
3. At the C:\windows prompt, type [msd] and press [Enter].
4. Type [v] to enter the Video window.  Information about your video card,

including the manufacturer's name, will be displayed.
5. To exit the Video window, press [Enter].  To exit MSD, press [F3].

c.  My video card isn't listed on the drop-down driver list.
Windows 3.1 supplies 256-color drivers only for Video 7 SVGA boards.  If you

have another manufacturer's SVGA board, you must install the drivers for it.  These 
come bundled with your video board on a floppy disk labeled "VGA Utilities" or "OEM
Disk."  To install your drivers, you simply need to give the path of your driver and 
Windows will read it off your OEM disk.  Use File Manager to identify this path, as 
follows:

1. Run Windows and enter File Manager.
2. Insert your OEM disk into drive A (or other drive) and click on the icon 

for that drive.  Your files will be displayed.
3. Look for the file called "oemsetup.inf" in the Windows 3.1 directory.  

The name of this directory is the path for your drivers.

Now install your driver, following the instructions below.  Note:  You may need 
your Windows 3.1 disks to complete this process.

12



1. Enter Windows Setup in the Main program group.
2. From the Options menu, choose Change System Settings.
3. Click on the arrow at the right of the Display line to open the list of 

drivers.  Highlight the last entry: "Other display (Requires disk from 
OEM)."  A dialog box will ask you to specify the path of your display 
drivers.

4. Put the OEM disk in drive A (or other drive), close the drive door, and 
type the path to the driver; for example, [A:\win31].  Then choose the 
OK button.  A list of video drivers will be displayed.  Highlight the driver 
for your board and choose the OK button.

5. You may be prompted to insert a Windows 3.1 disk.  Follow the 
prompts in the dialog boxes until you return to the main Setup window.

6. From the Options menu, choose Exit.
7. Restart Windows.  The new setting will be in effect.

d.  I installed a 256-color driver and my screen went crazy.
You selected the wrong video driver, probably a Video 7 SVGA driver.  To 

correct your display, run Setup from C:\windows in DOS, as follows.  Note:  You can 
quit Setup at any time by pressing [F3].

1. Close Windows by typing [ALT+F4] and pressing [Enter].  This returns 
you to DOS.  (Do not use the MS-DOS Prompt icon in the Main 
program group.)

2. At the C: prompt, type [cd\windows] and press [Enter].
3. At the C:\windows prompt, type [setup] and press [Enter].
4. To restore your screen, reinstall the VGA driver.  Use the up or down 

arrow to highlight the Display line and press [Enter] to view your 
display options.  Now use the up or down arrow to highlight the line 
that reads "VGA."  Press [Enter].

5. Press [Enter] to accept the new setting.  This will return you to the DOS
prompt.

6. When you restart Windows, the new setting will be in effect.  Now 
install the correct SVGA driver by following the instructions in sections 
b and c.

e.  My video card runs more than 256 colors, but Matinee still doesn't work.
From Setup, temporarily install the 256-color version (SVGA 256-color 640 x 

480) of your 24-bit driver.  (You may need to install this from the OEM disk; if so, 
follow the instructions in section c). You can switch back to the 24-bit driver once 
Matinee is installed. 

f. I don't have an OEM disk with drivers for Windows 3.1.
If your "Video Utilities" disk is out of date (i.e., for Windows 3.0) or missing 

altogether, order a new disk from the video board manufacturer. This should be free 
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of charge.  We've listed below the most common SVGA boards, with their 
manufacturers' phone and fax numbers.

Q Vision
Compaq
800/345-1518
713/374-9679 (fax)

WARPspeed
Cardinal Technologies
717/293-3000
717/293-3055 (fax)

Paradise Accelerator Card for Windows
Western Digital
714/932-6250
714/932-6498 (fax)

Graphics Ultra
ATI Technologies
416/756-0718
416/756-0720 (fax)

Graphite Card
Hercules
800/532-0600
510/623-1112 (fax)

Windows VGA Model 8800, 8860
Genoa Systems
408/432-9090
408/434-0997 (fax)

SpeedStar 24X, Stealth VRAM
Diamond Computer Systems
408/736-2000 ext. 252
408/730-5750 (fax)

Fahrenheit 1280
Orchid Technology
510/683-0300
510/490-9312 (fax)
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SXVGA1, SVGAX2, SXVGA5
Boca Research
407/997-6227
407/997-0918 (fax)

Win-VGA
SPEA-Video 7
510/656-7800
510/659-9285 (fax)

Truevision Video VGA
Truevision
317/841-0332
317/576-7770 (fax)

g.  Matinee crashes on Install.
Matinee calls on the Windows Auto-Detect function, which automatically 

detects the video chip installed on your computer and suggests which drivers you 
should install.  On some computers, however, this function causes problems.  You 
can bypass this problem by turning off the video chip detector, as below.  (If your 
computer crashes before you get to the Auto-Detect box during the install, move to 
section VIII.)

1 Reinstall Matinee.
2 When the Auto-Detect dialog box is displayed, uncheck Auto-Detect.
3 In the subsequent install window, manually select your video chip.  If you 

don't know your video chip type or it isn't listed, keep the "Unknown" default option.

h.  Matinee crashes on Install BEFORE I get to the Auto-Detect box.
A. 1. Press Control Alt Delete once, then press enter.  This should bring you 

to the next dialog box in Matinee Setup.  If it doesn't go to section B.
2. Choose "Unknown" as your video controler chip type.

B. 1 Remove the write-protection on the first Matinee disk by sliding the 
write-protection notch down to cover the square hole on the right side of 
the disk.  Insert the disk into your drive A or B. 

2 Run Windows and enter Notepad in the Accessories program group.
3 From the File menu, choose Open and type [A:\matinee.mst] or [B:\

matinee.mst] in the File Name box.
4 From the Search menu, choose Find.  Type [videotype] as one word In the

"Find What?" box and choose the Find Next button.
5 Highlight the entire line reading "VideoType% = GetVideoInfo()."  Note:  

Before continuing, make sure that you have highlighted only this line.
6 Press [Delete] on your keyboard.
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7 From the File menu, choose Save and then Exit.
8 From Program Manager, open the File menu and choose Run.
9 Type [A:\setup.exe] or [B:\setup.exe] in the "Command Line" box.
10 Follow the prompts on your screen until you get to the Video Controller 

Chip Type dialog box.  Check "Unknown."
11 The Install will be interrupted by an error message reading "file copy error, 

etc."  Choose the Ignore button.
12 Matinee will now install properly.

i.  During Install, I get the error message "No free file handles."
1 Run Windows and enter Notepad in the Accessories program group.
2 From the File menu, choose Open and type [C:\config.sys] in the File 

Name box.
3 Increase the number of file handles by changing the line reading 

[files=(number)] to [files=99].
4 Restart Windows.  The new setting will be in effect.
5 Reinstall Matinee.

j. After Matinee installs, I get the error message "Could not open file C:\dos\
doshlp."

Choose the Ignore button and restart Windows.

k.  When I click on the Matinee Edit or Matinee Play icon, I get the error message 
"No application is associated with this file."

Restart Windows after installing Matinee.

l.  When I click on applications other than Matinee Edit or Matinee Play, I get the 
error message "No association exists for this file."

1. Exit Windows
2. At the DOS Prompt, type [edit c:\windows\win.ini].
3. Go the line reading [Programs=scr] (about the ninth line down).
4. Change this line to read: [Programs=com exe bat pif scr].
5. From the File menu, choose Save and then Exit.
6. Restart Windows.  The new setting will be in effect.

m.  When I click on the Matinee Edit or Matinee Play icon, I get the error 
message "This application cannot run in standard mode."

To play Matinee, run Windows in enhanced rather than standard mode, as 
follows:

1. Close Windows.
2. Type [win /3] at the C:\prompt.  This runs Windows in enhanced mode.

If your computer automatically runs Windows after booting, you will need to 
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edit your autoexec.bat file.
1. Enter Notepad in the Accessories program group.
2. From the File menu, choose Open and type [C:\autoexec.bat] in the File 

Name box.
3. Change the last line from [Win] or [Win /s] to [Win /3].
4. Restart Windows.  The new setting will be in effect.

n. Matinee installed, but instead of video I have horizontal lines or static.
Reinstall Matinee, choosing Unknown as your Video Controller Chip Type.

o.  Matinee doesn't play inside the television.
Reinstall Matinee, choosing Unknown as your Video Controller Chip Type.

Note that the size of any given  AVI clip may not be the same as the video 
clips that Matinee comes with. Because of this, you may wish to set your 
background to a simple black screen.

p. I get the error message:  REEL.LST is damaged.
You have put too many video clips on your film strip.
From File Manager, delete the REEL.LST file from the C:\MATINEE directory.

q.  Matinee will not come up as the screen saver after the number of minutes I've 
specified in Control Panel.

This problem occurs when Talking Monitor (an application that comes with 
Aristosoft's Wired for Sound software) is autoloaded.  Refer to your Aristosoft 
manual to un-autoload Talking Monitor.  If you have any questions about Wired for 
Sound, contact Aristosoft at:  Tel: (510) 426 5355  Fax:(510) 426 6703  BBS:  (510) 
426 5641.

r.  I can't use Matinee because I have Idywild autoload when I start Windows.
1. Run Windows and enter Notepad in the Accessories program group.
2. From the File menu, choose Open and type [C:\win.ini] in the File Name 

box.
3. Change the line reading [load=(idylwild.exe)] to [load=].
4. Restart Windows.  The new setting will be in effect.

If you have any questions or suggestions about Matinee, please 
contact:

Access Softek
2550 9th Street, #206
Berkeley, CA   94710-2554 U.S.A.
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Tel: (510) 848-0606  Fax: (510) 848-0608
CompuServe 76702,776   MCI Mail 337-5316
BBS (510) 848-6805  Info Line (510) 848-3095

C. The Morphology 101 shell
1. Licensing Agreement:

See the Back Page of the Morphology 101 manual.

2. Troubleshooting:
The "Copy Image to Clipboard" button is designed to work with PhotoMorph, 

PhotoMorph Lite, and Conversion Artist. Not all image editing software will recognize
this format. The images can be found in the \images directory on the CD-ROM in the
.BMP file format. Most software will recognize this format.

The images on the CD-ROM are strored with 24-bit color information. 
However, when the image is copied to the clipboard, it is stored as a 256 color 
image. Users of 24-bit color displays and adaptors will want to read the files directly 
from the CD-ROM, rather than copying those files to the clipboard.

Because Morphology 101 executes MS Write to provide access to the 
description files and How the Pro's Morph, it is highly recommended that you avoid 
running MS Write and Morphology 101 simultaneously.

Morphology requires that a swap file be created in the 386 Enhanced settings
of the Control Panel. If you receive an "Out of Memory" error message, chances are 
you do not have a swap file. Consult your Microsoft Windows manual for instructions
in setting up a swap file.

SHARE, a DOS TSR program used in network and file security situations, 
may conflict with the Morphology 101 Setup program. Upon initial installation, 
SHARE will turn on the write protect bits of some of the files. If re-installation is 
attemped, errors may be encountered. If you must re-install Morphology 101, disable
SHARE and ensure that the write protect bits for the programs you with to re-install 
have been turned off. See your DOS manual for further information about SHARE 
and Write Protect Bits.

D. PhotoMorph Patch
1. Licensing Agreement:

The licensing agreement remains unchanged from the original licensing 
agreement you were bound into by opening your original PhotoMorph diskette 
envelope. If you install this patch over a pirated copy of PhotoMorph, we reserve the 
right to do bad things to you. 
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2. Troubleshooting:
If the PhotoMorph Patch in the setup program will not install over your copy of

PhotoMorph, one of the following must be true:
1. You are attempting to install over PhotoMorph Lite (which is included on 

Morphology 101).
2. You are attempting to install over the PhotoMorph Demo.
3. You are attempting to install over a copy of PhotoMorph that the upgrade 

program does not recognize.

Because the PhotoMorph 1.2a patch is only available to PhotoMorph 1.01 
and 1.20 users, the first two cases do not apply. However, it is possible that you 
have a released version of PhotoMorph that is not 1.01 or 1.20. If this is the case, 
call 508-392-1362 for upgrade information. Please note that PhotoMorph 1.2a and 
PhotoMorph Lite are the only two versions of PhotoMorph that can access the .PMP 
files directly from the CD-ROM.

E. Video For Windows runtime
1. Licensing Agreement:

Microsoft grants to you the right to reproduce and distribute the runtime 
modules of the SOFTWARE provided that you: (a) distribute the runtime modules 
only in conjunction with and as a part of an application program or data file, and not 
as part of any operating system or utility program, or on a standalone basis; (b) do 
not use Microsoft's name, logo, or trademarks in any marketing or advertising; (c) 
include a valid copyright notice on your product; and (d) agree to indemnify, hold 
harmless, and defend Microsoft and its suppliers from and against any claims or 
lawsuits, including attorneys' fees, that arise or result from the use or distribution of 
your product which incorporates the runtime modules.  The "runtime modules" are 
those files in the SOFTWARE so identified in the written materials accompanying the
SOFTWARE.  If required in the SOFTWARE documentation, you agree to display 
the designated patent notices on the packaging and in the README file of your 
product.  The license in this section to distribute the runtime modules is royalty-free 
provided that your application program or data file incorporating the runtime modules
is created for operation on the Microsoft(R) Windows(TM), Windows NT (TM), or 
Modular Windows (TM) operating systems.  Please contact Microsoft for the 
applicable licensing terms for all other uses of the runtime modules.

2. Troubleshooting:
You may see a "profiling display" message after you install or after changing 

the display driver.  This is normal.  The system is determining the fastest method to 
talk to your display driver.

You may get an error message regarding display preformance problems. 
Although VFW 1.1 seems to correct this problem, it usually occurs with 32k color 
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drivers. If you receive this error message, you can either ignore it, contact your video
board manufacturer, or choose a different display driver in your Windows Setup.

F. Aniplay
1. Licensing & Troubleshooting:

See the on screen Aniplay program documentation.
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III Special Offers
A. PhotoMorph
Call us for a special upgrade price to PhotoMorph 1.2a (if you don't already have it)

That's a $149.00 program that includes:
High Quality Morphing & Warping
Output to FLC animation files
Output to individual frames.
Image Editing
Screen Capture
Distortion Effects
Transition Effects
Image Editing Filters

And so much more!

Call 1-800-274-9674 today! 
or write:
Morphology 101 to PhotoMorph 1.2 upgrade offer
Andover Advanced Technologies
239 Littleton Road, Suite 2A
Westford, MA 01886
FAX: 508-392-0458
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